
Læs mere om...

Introduktion
Flash er et program der bruges til at fremstille animation og inter-
aktion i - især til Internettet. I forhold til andre tilgængelige tek-
nologier er Flash-filer meget små rent datamæssigt. Årsagen er, at 
man arbejder med vektorbaseret grafik. I vektorgrafik beskrives 
billedets elementer (linier, kurver, former) matematisk, hvorimod 
bitmapgrafik (såsom billeder fra Photoshop), er en beskrivelse af 
hver enkelt pixel. Vektorgrafik kan i modsætning til bitmapgrafik 
skaleres uden kvalitetstab. Af andre programmer, der anvender 
vektorgrafik kan nævnes  Illustrator.
Det kræver et ekstra program (Plug-in) af afspille Flash-filer. Det er 
præinstalleret i alle nyere browsere, men hver gang der kommer en 
ny version af Flash, kræver det også at browserne opgraderes. Det 
nyeste Plug-in kan downloades på Adobes website.
Flash har sit eget format man genmmer arbejdsfiler i. Når du gem-
mer en fil i Flash (Save eller Save as) får den efternavnet .fla. En 
sådan fil kan du åbne i Flash og arbejde videre på senere (svarer 
til en psd-fil i PhotoShop). Når du er færdig med din film, skal den 
eksporteres. Filen får efternavnet .swf og dette format kan læses 
af en browser og kan altså bruges på en webside. En swf-fil kan 
ikke genåbnes i Flash, derfor bør du altid gennem en arbejdskopi i 
formatet .fla.

Grundlæggende begreber i programmet
Når du åbner programmet Flash CS4, kan du i øverste højre hjør-
ne vælge hvordan din brugerflade skal se ud. Jeg har valgt Desig-
ner som brugerflade til dette kursus.

Properties (egenskaber)           Timeline (Tidslinien)	   Stage (hovedscenen)

.swf - den pakkede fil, 

som du kan oploade til 

Internettet.

.fla - den åbne flashfil 

med lag som kan 

redigeres.
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Læs mere om...

Programmet findes kun på engelsk. Det betyder at hjælpefunk-
tionen samt tilgængeligt materiale fra Adobe også er på engelsk. 
I materialet bruger jeg derfor de engelske ord og begreber, men 
forsøger at oversætte og/eller forklare dem undervejs.
En Flash-fil kaldes en movie, i materialet en film og kan inddeles 
i scenes (scener). Selve den flade man arbejder på kaldes Stage. 
I materialet her bibeholdes ordet Stage som betegnelsen for ho-
vedscenen, da en film kan bestå af flere scener.

Layers       Keyframes             Frames       Playback head

Timeline
Animation laves vha. Timeline (tidslinien). Tiden inddeles i frames 
(enkeltbilleder), som fyldes med grafik, figurer, tekst, knapper 
osv. Playback head (afspilningshovedet) kører hen over de enkelte 
frames og afspiller på den måde filmen. Man placerer de enkelte 
elementer; grafik, figurer, tekst, knapper osv. på hvert sit lag. På 
den måde kan de animeres uafhængigt af hinanden. Keyframes er 
frames, hvor der sker ændringer i animationen, f.eks. bevægelse, 
farveskift, lyd der starter/stopper eller lignende.
Forskellige animationsteknikker
Det er heldigvis ikke sådan, at du behøver at kunne tegne for at 
anvende programmet. I “gammeldags” animation, tegnes hver en-
kelt frame. Det er meget tidskrævende, da man for hver keyframe, 
skal tegne indholdet i dets nye udseende og position. Ofte vil man i 
stedet anvende en af de andre teknikker Flash byder på. 

Tweening
Mellem to keyframes kan man tweene, dvs. programmet regner 
selv ud, hvorledes de mellemliggende frames skal se ud. Her findes 
3 forskellige metoder:
- �Classic Tween: en bevægelse fra ét punkt til et andet i lige linier.
- �Motion tween: også til bevægelse af en figur fra ét punkt til et an-

det, minder meget om Classic Tween, men her behøver det ikke 
kun at være lige linier, man kan trække bløde kurver.

- Shape Tween: Tween på ren vektorgrafik, altså ikke til fotos. 
  Bruges til at ændre facon/form fra en figur til en anden.

Introduktion

Ingen frames
Blank keyframe
Keyframe
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Læs mere om...

Motion Tween ses startende med en sort prik (keyframe) og de 
mellemliggende frames er vist med en lille sort prik på lysblå 
baggrund i timeline. Man flytter figuren rundt på forskellige posi-
tioner. Timeline bliver opdateret fra frame til frame. På Stage vil 
du kunne se den path (sti) som figuren følger. Den er vist med 
grønne prikker.

Classic Tween starter og slutter med en keyframe (en sort prik). 
De mellemliggende frames er vist med en ubrudt sort pil på lys-
lilla baggrund.

Shape Tween starter og slutter med en keyframe (en sort prik). 
De mellemliggende frames er vist med en ubrudt sort pil på grøn 
baggrund.

En keyframe vises med en sort prik. Frames med lys grå farve 
efter en keyframe fortæller at indholdet er statisk. Slutningen af 
sekvensen vises med et lille rektangel.

Den oftest forekommende fejl, man begår i starten, er at glem-
me at indsætte en keyframe i sidste frame. En stiplet linie viser 
at den sidste keyframe mangler.

Motion Tween

Classic Tween

Shape Tween

Statisk indhold

Hvorfor virker det ikke?

Introduktion
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Læs mere om...

Symbols
Symbols (symboler) er figurer, der kan genbruges. Det er godt at 
gøre brug af symbols. De skal kun downloades én gang, og kan 
derefter genbruges i forskellige størrelser og farver. Symbols har 
deres egen Stage og Timeline. Hvis du skal rette i et Symbol, skal 
du ind i symbolets egen Stage. Rettelsen vil slå igennem alle de 
steder, du har brugt det. 

Der findes 3 slags symbols: 
- Buttons (knapper): Buttons har kun 4 frames (tilstande). 
   Up, Over, Down, Hit. 
- Graphic: Har sin egen Timeline, men den er afhængig af
  Timeline på Stage. 
- Movie Clip: Har sin egen Timeline, der kører uafhængigt af 
  Timeline på Stage.

Shapes
Alle de figurer du tegner i Flash med tegneværktøjerne, er som 
udgangspunkt Shapes. Dette betyder at du kan lave Shape Tweens 
på dem, men hvis du i stedet, ønsker at lave en Motion Tween, skal 
figuren konverteres til Symbol. Herunder ses de 2 forskellige typer 
figurer. Shapes er kendetegnet ved at være prikkede (rastererede) 
og Symbols har en blå ramme og et lille tegn i midten.

Library
Symbols, graphic, buttons mm., til den igangværende movie gem-
mes i Library (biblioteket). 
Du kan trække objekter fra Library ind på Stage. Hvert objekt på 
Stage er et Instance (eksempel eller udgave) af et symbol. Dette 
Instance kan man give et navn. På den måde kan man henvise 
til objektet i en evt. programmering, f.eks. er det nødvendigt at 
navngive buttons, da de skal styres af ActionScript. Navngivningen 
foregår i Properties.

Introduktion

Shape Symbol/graphic

Her navngiver du f.eks. buttons
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Læs mere om...

Properties panel
Dette panel skifter indhold/funktion alt efter, hvilket element der er 
aktivt. Her er et par eksempler på hvordan Properties kan se ud

Stage aktiv				            Text Tool aktivt

Button aktiv

Introduktion
Her ses Library med 3 forskellige typer 
objekter. Hver type har sit eget ikon.

cirkel: En figur - kan være enten
Symbol eller Shape
propel: Movie Clip
spil: Button
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Læs mere om...

Tools
Værktøjskassen i Flash indeholder værktøjer til at tegne med, ska-
lere, fritlægge, samle farver op, lægge farver i m.m. Du vil opleve, 
at den kan se forskellig ud alt efter, hvilklet værktøj du har valgt. 
De værktøjer, som har en lille sort trekant i nederset højre hjørne, 
gemmer på yderligere værktøj af samme slags. Hold musen nede 
på den lille trekant og værktøjets menu foldes ud.
Her ses Oval Tool med gruppen af underliggende værktøjer.

Farver
Ved at klikke på Fill eller Stroke kan du vælge farver. Ét klik giver 
dig farvekassen til venstre med et begrænset antal farver. Klik på 
det lille farvehjul i øverste højre hjørne, og du får en trinløs farve-
kasse frem, som den til højre.

Stroke (kontur)	 Fill (fyld)

Introduktion
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Læs mere om...

Hvis du har arbejdet med Flash i CS3, vil du måske vide, at i CS3 
hed Classic Tween Motion Tween. Dette materiale er udviklet til 
CS4, og her er Classic Tween en ret bevægelse mellem 2 punkter. 
En Classic Tween starter og slutter altid med en keyframe (en sort 
prik). De mellemliggende frames er vist med en ubrudt sort pil på 
lyslilla baggrund.

Skal du lave flere/nye positioner, altså flytte figuren mere en 1 
gang, skal der indsættes flere Keyframes. Classic Tween er kende-
tegnet ved, at du kun kan flytte figurer i lige linier.

Timeline med flere Classic Tweens. Det er vigtigt at dine Tweens 
ligger på hvert sit lag, ellers kan du ikke animere figurerne indivi-
duelt. Der kan altid sættes flere Keyframes ind, og du kan fjerne 
Keyframes igen, hvis du har fået lavet for mange.

Indsæt et Keyframe: Højreklik det sted du ønsker at sætte et 
Keyframe ind og vælg Insert Keyframe eller vælg F6.
Fjern et Keyframe: Højreklik på Keyframen og vælg Clear Key-
frame.

Classic Tween
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Opgave

Øvelse

Lav et simpelt Classic Tween, hvor du animerer en kugle. Først 
tegner du kuglen, derefter skal den animeres, altså flyttes fra én 
position til en anden.
•	 	 Vælg Create New Flash File.
•	 Placer dig på Timeline i 1. frame.
•	 	 Navngiv laget kugle
•	 Lav en cirkel med Oval Tool.
•	 I timeline markeres frame 15.
•	 Højreklik og vælg Insert Keyframe, eller brug 
         tastaturgenvejen (F6).
•	 Mens du har markeret frame 15, flytter du cirklen med  
         Arrow Tool til en ny position.
•	 Højreklik et sted i Timeline imellem de 2 keyframes, og vælg 	
	 Create Classic Tween.
•	 Vælg Enter og se kuglen bevæge sig. 
•	� Vælg Save As, arkivér filmen som kugle.fla. Vælg 

Ctrl.+Enter, der genereres nu en .swf fil, som kan importe-
res til f.eks. Dreamweaver.

Når du vælger Ctrl+Enter, og på den måde får vist filmen, som den 
vil tage sig ud i browseren, vil du se at den looper. Det er standard 
for alle Flash film, de fortsætter i det uendelige, indtil de får andet 
at vide. Man styrer, hvorvidt filmen skal loope eller kun spille én 
gang ved hjælp af ActionScript.

Classic Tween
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Opgave

Classic Tween
Indsæt en Stop Action

•	 	 Markér sidste frame i filmen.
•	 	 Højreklik og vælg funktionen Actions, eller vælg tastatur-		

	 genvejen F9.
•	 	 Skriv følgende i scriptvinduet: stop();
•	 	 Luk scriptvinduet og vælg Ctrl+Enter for at se, at filmen 		

	 stopper efter én gennemspilning.

Scriptvinduet med kommandoen stop.

Det lille a indikerer, at der er tilknyttet ActionScript.

Opgave
Fremstil et billardbord med 3 kugler. Opret et lag til hver kugle, 
således de kan animeres hver for sig. Stage gives en grøn farve 
som klædet på et billardbord. Lad kuglerne støde ind i hinanden og 
i banderne.
Brug funktionen Properties > Ease (deacceleration) så kuglerne mi-
ster lidt fart, inden de stopper. På den måde ser det mere naturligt 
ud. Du skal stå på 1. keyframe i en Tween, for at funktionen kan 
vælges i Properties. Opgaven kan udbygges med en kø, som sky-
der til kuglerne. Det kan være et poolbord i stedet, der kan tegnes 
huller og kanter på bordet - brug fantasien. 

100: Sænker tempoet på 
kuglens sidste frames 
(deacceleration)

-100: Sænker tempoet på 
kuglens første frames  
(acceleration)

Farven på Stage ændres 
ved at klikke på firkanten til 
højre for Stage i Properties.
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Opgave

I Timeline ses statiske frames (grå) og Tween (lyslilla). Hver key-
frame betyder, at der kan ske en ændring. Her ændrer kuglerne 
retning.

Aflevér opgaven som aftalt med din underviser.
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Læs mere om...

Det er oplagt, at man ikke kan nøjes med at lave animationer, hvor 
figurerne kun bevæger sig i lige linier. Ved at bruge Motion Tween 
kan du lave bløde buer. 

En Motion Tween starter altid med en Keyframe (en sort prik). De 
følgende frames er vist på blå baggrund. Flash sætter selv Keyfra-
mes ind, der hvor du foretager ændringer, det er ikke almindelige 
Keyframes, men Property Keyframes. Det betyder, at de er for-
bundne, og du kan ikke kun slette en enkelt Property Keyframe.

Hvert af de grønne punkter på Stage repræsenterer en frame. Du 
kan trække i dem, og derved ændre stien figuren følger. Ved at 
bruge Subselection Tool (den hvide pil), kan du arbejde med finju-
stering af buerne. Vælg værktøjet og klik i et endepunkt. Der frem-
kommer nu Bezirhåndtag, (kendt fra bl.a. programmet 
Illustrator).

Motion Tween

Keyframe Property Keyframes
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Opgave

Opgavebeskrivelse
Lav et simpelt Motion Tween, hvor du animerer en kugle. Først 
tegner du kuglen, derefter skal den animeres (altså flytte sig fra 
én position til en anden). Præcis som i den sidste opgave, men 
her er der mulighed for bløde kurver.

•	 	 Åbn en ny Flash File.
•	 	 Vælg Selection Tool og klik på Stage.
•	 	 Sæt størrelsen på Stage til 400 px x 200 px.
•	 	 Navngiv laget bold
•	 	 Markér Timeline, 1 frame.

•	 Lav en udfyldt rød cirkel med Oval Tool.
•	 Højreklik på cirklen og vælg Convert to Symbol eller (F8).
•	 I Timeline vælges frame 5.
•	 Højreklik og vælg Insert Frame eller (F5).
•	 Når du står i frame 5, højreklikker du og vælger 
	 Create Motion Tween, Type: Graphic
•	 Flyt cirklen til en ny positionen vandret mod højre.

Motion Tween
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Opgave

•	� Gentag proceduren (F5) således du har 5 positioner og er 
nået til frame 20.

	
•	 	 Tag fat i den første Property Keyframe på Stage og flyt den 	

	 lodret op, (ved cursoren ses en vinkel).

•	 	 Gentag proceduren med den 4. Property Keyframe.

•	 	 Bolden hopper op og ned i lige linier. Du skal nu ændre 		
	 linierne til bløde buer. Tag fat i et punkt midt på linien 		
	 og træk skråt opad, ved cursoren ses en lille bue.

Motion Tween

På Stage vil du se 
en grøn streg med 
en masse prikker. 
Hver prik repræ-
senterer en frame. 
De lidt større prik-
ker er Property 
Keyframes. 
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Opgave

•	 	� Arkiver filmen under navnet ”hoppebold”. Vælg Ctrl.+Enter, 
der genereres en .swf fil som kan importeres i f.eks. 
Dreamweaver.

•	 	 Aflever opgaven som aftalt med din underviser.

Motion Tween
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Læs mere om...

Denne form for tweening kræver figurtypen Shape for at fungere, 
den virker altså ikke på Symbols, grupperede elementer samt tekst 
og billeder.
Med Shape Tween kan du lave en animation, hvor én figur glider 
over i en anden, dvs. skifter facon. Shape Tween kendes i Time-
line ved den grønne farve med en ubrudt pil. Shape Tween er kun 
anvendeligt til meget enkle figurer. Hvis der er tale om komplekse 
figurer, vil du opleve at tweeningen bliver meget ”psykedelisk”. Det 
er ligeledes ikke nogen god idé, at lave Shape Tween på en figur 
med Stroke, da transformeringen af denne kører uafhængigt af 
selve figuren.

Shape Hints
Det kan være en hjælp at indsætte Shape Hints for at styre anima-
tionen bedre.
Shape Hints sættes på første og sidste frame for at styre bevægel-
sen på de punkter, der skal ”smelte sammen”. Der kan maximum 
anvendes 26 Shape Hints.
Shape Hints er gule i den første Keyframe, grønne i den anden, og 
røde hvis de ikke ligger rigtigt på figuren, de skal placeres på kan-
ten, eller når de ikke er placeret i begge Keyframes - både start og 
slut.

For at opnå det bedste resultat med Shape Hints, bør du følge ne-
denstående retningslinier 
 
Sørg for at punkterne er placeret logisk. Hvis du bruger 3 Shape 
Hints til en trekant, skal de ligge i den samme rækkefælge på 1. 
figur og på 2. figur. 
Shape Hints virker oftest bedst, hvis du placerer dem modsat urets 
retning begyndende i det øverste venstre hjørne af figuren, men 
prøv dig frem. 

Shape Tween
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Opgave

Shape Tween
Opgavebeskrivelse

•	 Åbn en ny Flash File.
•	 Sæt størrelsen på Stage til 200 px x 200 px.

•	 Placer dig på Timeline i 1 frame.
•	 Vælg Rectangle Tool og lav en blå kvadrat uden Stroke.
•	 Vælg Selection Tool (sort pil) og markér hele kvadratet ved at 

trække musen henover. 
•	 Åben Properties. Der er 4 indtastningsfelter W:, H:, X:, og Y:

I alle indtastningsfelter skriver du 50. Nu har du et kvadrat, der 
er 50 px gange 50 px, med det øverste venstre hjørne placeret 
50 px fra toppen, og 50 px fra venstre.

•	 Højreklik i frame 20 i Timeline og vælg Insert Blank Keyframe 
eller (F7). Din firkant skal nu være forsvundet.

•	 Vælg Oval Tool og træk en rød cirkel uden Stroke omtrent på 
den position, hvor firkanten før befandt sig.

•	 Markér cirklen med Selection Tool og skriv igen i Properties 
50 px i alle 4 indtastningsfelter. Nu er cirklen og firkanten pla-
ceret nøjagtig over hinanden. 

•	 Markér Frame 1 i Timeline. Højreklik og vælg 
Create Shape Tween. Din Timeline bliver grøn 
med en ubrudt pil.

Nu har du en firkant, der bliver til en cirkel. Skulle du føle trang 
til at få cirklen til at blive til firkant igen, så der hele tiden skiftes 
mellem de to faconer, kan det gøres på følgende måde:
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Opgave

Shape Tween

•	 Højreklik på de grønne frames og vælg Select all Frames.
•	 Højreklik og vælg Copy Frames.
•	 Markér frame 21 i Timeline, højreklik og vælg Paste Frames.
•	 Markér frame 21 til 40 ved at trække hen over disse, således 

at alle de netop indsatte frames er valgt. 

•	 Højreklik og vælg Reverse Frames (vend sekvensen om/spil 
baglæns). Nu vil figuren skifte frem og tilbage mellem firkant 
og cirkel, og der forekommer ingen brat overgang.
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Flash er ikke et tekstbehandlingsprogram... 
Alligevel findes der mange faciliteter hvad angår behandling og 
opsætning af tekst i programmet. Du kan arbejde med Static Text 
som er almindelig tekst, men programmet kan også håndtere 
Dynamic Text, som bruges til interaktive websider, hvor brugeren 
f. eks. udfylder en formular. Du kan vælge font, farve, størrelse, 
skydning (afstand mellem linier), knibning (afstand mellem de 
enkelte bogstaver) og flere andre ting. Med tekstværktøjet aktivt, 
finder du tekstredigeringsmulighederne i Properties, her vises de 
mest brugte.

Tekst

Skrifttype

Afstand mellem 
bogstaverneStørrelse

Auto afstand 
mellem bogstaverne

Udglatning af kanter

Retning

Linjeafstand
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Der er en indbygget stavekontrol, og du kan vælge mellem for-
skellige sprog.

Tekst som grafik
Alle figurer der tegnes i Flash, er Shapes, dvs. at de kan tilde-
les Shape Tweening. Tekst er ikke Shape, men derimod Symbol, 
og skal derfor konverteres til Shape for at kunne tildeles Shape 
Tweening. Funktionen hedder Break Apart. 

Tekst

Uden Break Apart      Break Apart 1 gang       Break Apart 2 gange
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Opgave

•	 Åbn en ny Flash File.
•	 Sæt størrelsen på Stage til 300 px x 100 px.
•	 Markér frame 1 i Timeline. 
•	 Vælg Text Tool, vælg en rød farve, font - en stor størrelse, og 
skriv ordet MAD.

•	 Vælg Selection Tool og vælg menuen Modify > Break Apart. Or-
det bliver delt i 3 Symbols, ét for hvert bogstav. 

•	 Vælg Modify > Timeline > Distribute to Layers. Bogstaverne 
bliver lagt på hvert sit lag. Det øverste lag er tomt, dette kan 
slettes.

Tekst
Opgavebeskrivelse

Fremstil en Flash film hvor de tre bogstaver M A D kommer tum-
lende ind på scenen, animeret hver for sig.
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Opgave

Tekst
•	 Placér de tre bogstaver udenfor scenen og lav f. eks en Classic 

Tween. Bogstaverne skal ende på Stage og give ordet MAD.

•	 Efter tweeningen sættes et stykke ind med Static Frames.
Træk henover alle 3 lag og vælg (5).På den måde står teksten 
stille lidt, inden filmen starter igen.

Aflevér opgaven som aftalt med din underviser.
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Det mest anvendte videoformat på internettet i dag er FLV (Flash 
Video).
Du kan importere og anvende video på flere måder i Flash. Du kan 
importere et videoklip, så det bliver en del af Flashfilen, metoden 
kaldes Embedded Video.
Du kan konvertere dit videoklip til Flash-videoformatet FLV, og 
anvende det f.eks. i Dreamweaver.
Du kan streame video. Dette kræver at videofilen ligger på en 
Streaming Server der hedder Flash Media Server. Med denne teknik 
kan man også distribuere live video.
Adobe anbefaler kun Embedded Video til korte sekvenser 0-5 sek, 
og FLV filer til sekvenser mellem 0 – 30 sek. Til sekvenser over 30 
sek. anbefales streaming.
Konverteringen foregår via programmet Adobe Media Encoder, 
som er en del af CS4 pakken. 

 
Du kan anvende følgende formater (Mac og PC): 
AVI, MPEG, MPG, DV og MOV (kræver Quicktime installeret).
Hvis du har DirectX7 eller nyere installeret, kan du også anvende 
WMV og ASF i Windows.

Video er stadig meget tungt på internettet, så det er vigtigt at 
bruge det med omtanke - lav ikke dine klip for lange.

Video
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Opgave

Opgavebeskrivelse

•	 Download videoklippet lissabon.mpg fra kursusmaterialet. 
•	 Start programmet Adobe Media Encoder, programmet til at 
konvertere filer til bl. a. .fla.

•	 Vælg Add og tilføj filen lissabon.mpg eller træk filen ind i det 
store felt i midten.

•	 Vælg Settings.

Video
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Opgave

•	 Vælg format FLV/FV4 øverst til højre

•	 Vælg Preset FLV - Web Medium Wide screen

Filmen starter med nogle farvede felter (colorbars), de skal klip-
pes fra. Ligeledes skal du klippe noget fra i slutningen. Filmen skal 
slutte med pigen der går på fortorvet, lige før lastbilen kører ind 
fra venstre. Klippet bliver ca. 10 sek. langt.

•	 Træk i de små trekanter i hver ende af tidslinien, til det rigtige 
klip er fundet.

Video

Tidslinie
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Opgave

•	 Under Output Name kan du give filmen et nyt navn, og bestem-
me hvor den skal arkiveres.

•	 Vælg OK i nederste højre hjørne, du vender nu tilbage til den 
første dialogboks.

•	 Vælg Start Queue for at sætte konverteringen i gang.

Du kan følge med i, hvor lang tid det tager at konvertere klippet.

Video
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Opgave

Når konverteringen er færdig ses et gønt flueben ud for Status.

Nu er filmen klar til at f. eks. at blive sat ind på en webside i 
Dreamweaver.

Afspilningspanel
Det er en rigtig fornuftig idé at sætte et afspilningspanel på filmen, 
således at brugeren selv kan bestemme om og hvornår, filmen skal 
ses, pauses, gentages m.m. 
Når du placerer filmen på en html side i Dreamwever,
kan du vælge, hvilket afspilningspanel der ønskes.

Det samme, bare i Flash
•	 Opret en ny Flash Movie.
•	 Vælg Import > Import Video.
•	 Vælg Browse og find filmen på din computer.

Video

De forskellige afspil-
ningspaneler findes 
under Skin.
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•	 Vælg et afspilningspanel. Vær opmærksom på, at de, der hed-
der SkinUnder, placeres udenfor filmen forneden.

•	
•	
•	
•	
•	
•	
•	
•	
•	
•	
•	
•	
•	
•	
•	
•	
•	
•	

Til sidst vises en dialogboks, hvor de valgte indstillinger vises. Der 
står også, at de ekstra filer som Flash selv genererer, skal 
uploades sammen med filmen. 
•	 Vælg Finish.

Video
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Video
Filmen genereres nu med afspilningspanelet på. Hvis du fortryder 
udseendet af afspilningspanelet og hellere vil vælge et andet:
•	 Vælg Properties > Component Inspector Panel. 

•	
•	

•	 Klik på linien Skin og derefter på den lille lup til højre. Du kom-
mer nu tilbage til boksen, hvor du kan vælge et nyt design til 
afspilningspanelet.

Når du er tilfreds med udseendet, arkiverer du filmen på normal 
vis. Husk du også skal uploade SWF filen, der indeholder afpilnings-
panelet til internettet.
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Filformater
Når du importer billeder eller grafik til Flash, kan flere forskellige 
filformater bruges. De mest brugte filformater, der importeres til 
Flash er:
JPEG - format der primært bruges til fotos.
GIF - format der primært bruges til simpel grafik.
PNG24 - format der bruges til filer med forløb, grafik eller fotos 
med transparent baggrund.
Flash kan også læse filer direkte fra Photoshop, altså psd filer 
og ai filer fra Illustrator. Det er vigtigt, at billederne fylder så lidt 
som muligt. Opløsningen bør være 72 dpi. 
Flash kan ikke Morphe, altså lave en Shape Tween mellem 2 bille-
der - således at de umærkeligt glider ind i hinanden. 
Man kan fritlægge et billede i Flash ved at vælge funktionen Mo-
dify - Break apart. Når billedet er splittet op i småbidder, kan man 
bruge lassoen eller viskelæderet.
Man kan opnå forskellige grafiske effekter ved at vælge Modify >  
Bitmap > Trace Bitmap. På denne måde laves billedet om til vek-
torgrafik. 

Foto/grafik

Her sammenlignes de enkelte 
pixels farveværdier og 
forskellene udregnes. Hvis 
du forhøjer tallet, reducerer 
du antallet af farver, og filen 
fylder mindre.

Minimum Area er et udtryk for 
de omkringliggende pixels. Jo 
mindre en værdi, jo mere nøj-
agtig bliver oversættelsen

Bestemmer hvor fint 
en outline skal 
tegnes/gengives.

Corner Threshold bestemmer 
hvorledes skarpe kanter skal 
gengives - nøjagtigt eller 
udglattes.

Ønsker man at skabe vektorgrafik, der ligner 
originalen (fotografiet) mest muligt, anbefaler 
Adobe disse indstillinger som udgangspunkt:

Color Threshold: 10
Minimum Area: 1 pixel
Curve Fit: Pixels
Corner Threshold: Many Corners
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Opgavebeskrivelse

Fremstil en film hvor du kombinerer anvendelse af fotos med Mo-
víeclip, Classic Motion Guide og tilfører filmen interaktivitet i form 
af to knapper. Start med at importere billederne til programmet.

•	 Download mappen Sommerfugl fra kursusmaterialet til din egen 
computer.

•	 Åbn en ny Flash File.
•	 Placér dig på Timeline i frame 1. Navngiv dette lag baggrund.
•	 Vælg File > Import > Import to Library. Hent billedet sommer-

fugl.jpg og billedet blomst.jpg. Du kan godt vælge begge filer 
på én gang.

•	 Hent blomsten ind på Stage, på laget baggrund. Forlæng laget 
til 40 frames. Baggrunden er statisk, så der skal ikke keyframes 
eller tweening ind af nogen art.

•	 Arkivér opgaven under navnet sommerfugl.fla Du skal arbejde 
videre på den senere.

Import af 
billeder

De to billeder i Library
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Movie Clip
Hvad er Movie Clip?

En Flash File kan bestå af mange små scener, du klipper sammen 
på Stage. 
Et Movie Clip har sin egen Timeline.
Et Movie Clip placerer sig i Library og trækkes ind på Stage herfra.
Et Movie Clip kan være en Shape Tween, Motion Tween eller Classic 
Tween, som fremstilles på helt normal vis, men i et seperat studie, 
som ligner Stage til forveksling. Den eneste synlige forskel er, et 
lille kryds, på midten af arbejdsområdet.
Et Movie Clip gives typisk betegnelsen _mc.

Hvad bruger man Movie Clip til
Til større produktioner er det smart at anvende Movie Clip. Time-
line på Stage bliver meget mere overskuelig, da du henter små 
færdige sekvenser ind, i stedet for at lave dem på Stage.

Eksempel: Du har indsat en Stop Action på din film, hvilket bety-
der, at filmen kun spiller én gang. Hvis du har anvendt et eller flere 
Movie Clip, som ikke har en Stop Action tilføjet, vil disse ikke blive 
påvirket af denne Stop Action du har indsat på Timeline på Stage. 
Et Movie Clip kan altså fortsætte med at spille, selvom filmen er 
stoppet. Se opgaven med sommerfuglen. 

�Her ses et Movie Clip. Bemærk det lille kryds på sommerfuglen, 
den synlige forskel på, at du ikke befinder dig på Stage.

Fra Stage, vender du tilbage til dit Movie Clip, ved at vælge det fra 
rullemenuen ved siden af vinduestørrelsen. 
Til højre ses Movie Clippet i Library.

Ikonet for 
Movie Clip 

Ved at klikke på 
Scene 1 kommer du 
tilbage til Stage
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Movie Clip
Opgavebeskrivelse

•	 Åbn filmen sommerfugl.fla.
•	 Vælg Insert > New Symbol > Mopvie Clip.

•	 Navngiv Movie Clippet flyv.
•	 Træk billedet af sommerfuglen ind på Movie Clippets Stage 

fra Library.
•	 Indsæt en keyframe i frame 10.
•	 Vælg Transform Tool og gør sommerfuglen smallere - dvs. 

forvræng den.

•	 Placér cursoren mellem frame 1 og 10, højreklik og vælg 
Create Classic Tween.

•	 Vend tilbage til Stage ved at klikke på det lille ikon Scene 1.
•	 Opret her et nyt lag, navngiv det sommerfugl og træk Movie 

Clippet flyv ind fra Library. Placér sommerfuglen på Stage.

•	 Forlæng laget til 40 frames, ved at indsætte en Keyframe i 
frame 40.

•	 Arkivér opgaven. Du skal arbejde videre på den senere.
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I gang med FlashLæs mere om...

Med Pencil Tool kan du selv tegne en Path (sti), som en figur 
skal bevæge sig efter. Dette kaldes en Classic Motion Guide, og 
den er tilknyttet Classic Tween - deraf navnet. Du tegner en Path 
på et selvstændigt lag, som er et særligt guidelag, og som kun 
bruges til dette formål. Du får fat i et guidelag ved at højreklikke 
på et almindeligt lag og vælge Add Classic Motion Guide.

I timeline vises laget med en buet stiplet linie, og navnet bliver 
Guide: samt navnet på laget, du højreklikkede på.

Det er vigtigt, at de to lag holdes samlet, dvs. at der ikke opret-
tes lag i mellem dem. Der kan godt optræde flere Classic Motion 
Guides i en Flash File.

Figuren følger den path, du tegner, men for at det skal se na-
turligt ud, skal figuren rotere sammen med Pathen. I Frame 1 i 
figurens lag vælges funktionen Orient to Path fra Properties, som 
betyder, at figuren drejer undervejs. Hvis ikke dette er nok, kan 
du sætte ekstra Keyframes ind og selv rotere figuren.

Classic 
Motion Guide
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Opgavebeskrivelse

•	 Åbn filmen sommerfugl.fla. Det er den film du har lavet, hvis du 
har gennemgået opgaverne under ”Import af billeder” og ”Mo-
vieclip”. 

•	 Placér sommerfuglen udenfor Stage, i nederste højre hjørne.
•	 Indsæt en keyframe i frame 40, og flyt her sommerfuglen ind 
på blomsten.

•	 Højreklik på laget og vælg Add Classic Motion Guide
•	 Lås laget sommerfugl ved at klikke på hængelåsen, således at 
du ikke kommer til at tegne på det.

•	 Markér guidelaget. Tegn den Path sommerfuglen skal flyve efter. 
Start et godt stykke udenfor Stage. Brug Pencil Tool, det er li-
gegyldigt hvilken farve du anvender, Pathen bliver ikke synlig på 
filmen. Vælg funktionen Smooth. Når du er tilfreds med stregen, 
er det en god idé at låse guidelaget med et klik ud for hængelå-
sen. Så kommer du ikke ved en fejltagelse til at flytte på stre-
gen, når du nu skal flytte på sommerfuglen.

•	 For at få sommerfuglen til at flyve efter stregen, skal den være 
hægtet på i begge ender, altså i første og sidste Keyframe. 
Frame 1 er som regel ikke noget problem. Sommerfuglen føles 
magnetisk og finder selv stregen, hvis ikke du har tegnet den alt 
for langt væk. Vælg nu sidste Keyframe og placér sommerfug-
len på stregen inde på blomsten. Det kan godt være lidt svært 
første gang, men tricket er, at du med Selection Tool (sort pil) 
skal tage fat i det lille kryds, der er på sommerfuglen, og træk-
ke det hen på stregen. Du kan se krydset, når sommerfuglen er 
valgt. Krydset bliver til en cirkel, når du flytter på sommerfuglen 
i punktet. 

•	 Med frame 1 markeret vælges Orient to Path i Properties. Nu 
følger sommerfuglen stregen mere naturligt.

•	 Kør manuelt med Playback Head hen over alle 40 frames, og 
indsæt evt. Keyframes, hvis der er brug for at rette op på som-
merfuglen. Vælg Transform Tool og rotér sommerfuglen ved at 
trække udenfor øverste højre hjørne. Du skal kunne se en lille 
knækket pil ved siden af cursoren.

Classic 
Motion Guide

Med Pencil Tool valgt 
kan du få hjælp af 
programmet til at 
glatte frihåndsteg-
nede streger ud.
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Stop Action i sidste 
frame er vist med 
et lille a. Senere 
skal du sætte en 
button (knap) på, 
således at bruge-
ren kan afspille 
filmen igen.

•	 Filmen skal kun spille én gang. Indsæt derfor en Stop Action i 
den sidste frame. Når filmen slutter, er sommerfuglen landet på 
blomsten, men vingerne bevæger sig stadig på grund af Movie 
Clippet. Markér sidste frame i laget sommerfugl. Vælg Actions 
enten ved at højreklikke eller tastaturgenvejen F9.

•	 Skriv kommandoen stop(); i scriptfeltet, ordet stop bliver blåt. 
Luk scriptvinduet igen.

•	 Arkivér filmen.
•	 Vælg Ctrl+Enter og kontrollér at filmen stopper efter én gen-
nemspilning. Du skal arbejde videre med den senere.

Classic 
Motion Guide

Transform Tool valgt. 
Husk at indsætte Keyframes, 
hvis du vil ændre på sommer-
fuglens vinkel.

Keyframes
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Interaktivitet
En stor del af de Flash Files, du ser på Internettet, er interaktive. 
Det betyder, at brugeren kan klikke et sted på skærmen og få en 
handling udført. Interaktivitet i en Flash File kan være mange 
ting. Det kan være links til en adresse på internettet, brugeren der 
kan bevæge sig rundt i filmen, springe fra scene til scene, eller en 
lyd der bliver spillet e.l. 
Interaktivitet styres i programmet af et progammeringssprog som 
hedder ActionScript. Med CS4 er vi nået til version 3.0. Du har mu-
lighed for både at vælge version 3.0 og 2.0 når du starter en Flash 
File. Dette materiale er udviklet til ActionScript 3.0

ActionScript 3.0
Selve programmeringsdelen i Flash er meget omfattende, Action-
Script er et sprog som kun Flash anvender, og det kan virke lidt 
uoverskueligt at komme igang med. På Facebook, findes ligefrem 
en side for folk, der hader at programmere i Actionscript 3.0! Hvis 
du vil arbejde seriøst med Flash, er det nødvendigt at kunne ar-
bejde med ActionScript, og der findes heldigvis rigtig mange bøger 
om emnet.
Du får fat i scriptvinduet ved enten at vælge tastaturgenvejen F9, 
højreklikke på et lag eller via menuen Window.

Til venstre hentes foruddefinerede scripts eller stumper heraf, og i 
den højre del skriver man selv. 
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Knapper
Til at styre interaktivitet kan man f. eks. bruge buttons (knapper).  
I Flash er buttons en unik type symbol, og disse fremstilles i et 
selvstændigt studie, ligesom det er tilfældet med Movie Clips. En 
button kan være en tegnet figur, men også et stykke grafik eller et 
foto. 
 
En button oprettes ved at vælge Ctrl+F8 eller Insert >New Symbol.

Studiet hvor knappen fremstilles, ser meget anderledes ud end 
Timeline til Stage.

En button kan have 4 forkellige tilstande. Disse tilstande vises i 
hver sin frame. 
Up –  en buttons normale udseende, dvs. det udseende en button 
har, når musen ikke er i kontakt med den. 
Over – vises når brugeren fører musen henover en button.
Down – vises når brugeren klikker på button.
Hit – det område, hvor en button er aktiv, dvs. hvor cursoren bliver 
til en pegende hånd, når den føres hen over en button. Hit-områ-
det er gennemsigtigt.
Det er en god idé at lægge tekst på et lag for sig. Buttons opret-
tes automatisk i Library og kan genbruges lige så mange gange det 
skal være.

Navngivning
For at kunne programmere en button er det nødvendigt at den har 
et navn. Man giver button et Instance Name i Properties. Det er 
almindeligt at give buttons betegnelsen _btn.

Interaktivitet

Ikonet for 
en button
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Opgavebeskrivelse

Filmen sommerfugl skal tilføjes 2 buttons. Den ene skal sætte 
filmen igang igen (du har jo sat en stopaction på) den anden skal 
åbne en webside fra Internettet 

•	 Åbn sommerfugl.fla

•	 Vælg Insert > New Symbol. Giv den et navn, i dette tilfælde 
spil, og vælg Button som Type. Klik OK. Du befinder dig nu i et 
nyt ”studie”, hvor du kan se de 4 tilstande for en button.

•	 Tegn en buttom i Up. Klik i næste frame (Over), indsæt key-
frame (F6), som opretter en kopi af indholdet fra frame 1. Fore-
tag evt. ændringer. 

•	 Indsæt en keyframe i Down, foretag ligeledes evt. ændringer 
(indholdet kan godt være det samme i alle tilstande).

•	 Til sidst indsættes en keyframe i Hit. Hit-området er usynligt, 
men sørg for, at det har ca. samme areal som i Up. 

•	 Indsæt et nyt lag, og navngiv det tekst. Skriv teksten i frame 1 
(Up), de 3 andre tilstande bliver automatisk udfyldt. 

Buttons
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•	 Vend tilbage til Stage og opret et nyt lag kald det spil, træk din 
button ud på Stage.  

•	 Vælg Ctrl+Enter for at teste den. Cursoren bliver til en hånd, 
når den føres henover din button, men der sker ikke noget, når 
man klikker på den, den skal først programmeres.

•	 Lav en button mere efter samme opskrift som tidligere, kald 
den www

•	 Placér den på et nyt lag. 
•	 Arkivér opgaven, du skal arbejde videre på den senere.

Buttons
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ActionScript

Spil filmen - igen 
Et meget anvendt script, er et script, som sætter filmen i gang når brugeren  
klikker på en knap. Der indsættes en stop-action i det første frame, hvilket 
betyder, at filmen slet ikke går i gang, før der bilver klikket på en knap.

Forklaring
stop();  > Filmen er stoppet, brugeren bestemmer hvornår filmen skal spille, 
ved at klikke på knappen.
afspil_btn  > Knappen du har navngivet.
addEventListener(MouseEvent.CLICK >  ”Lytter på”, registrerer at der klik-
kes på knappen.
klik >  et tilfældigt navn, som du synes er logisk. 
gotoAndPlay (1) >  Når knappen »hører« navnet klik, så udfører den en 
funktion. I dette tilfælde, at gå til frame 1, spiller altså filmen forfra.

ActionScript er det programmeringssprog Flash anvender til al 
interaktivitet. Interaktivitet skal her forstås som inddragelse af 
brugeren. Typisk sættes der knapper eller tekstlink på filmen, ”Klik 
her og se straks om du har vundet”, har du nok stødt på, på Inter-
nettet. Knapper eller tekstlinks programmeres i Flash til at foreta-
ge en eller anden form for handling. Det kan f. eks. være at afspille 
en lyd, at åbne en side på Internettet eller at gå til en anden frame 
i filmen. 
Det er svært at komme udenom ActionScript, det er en meget stor 
del af Flash, og selv enkle animationer skal somregel anvende lidt 
programmering. Det kan virke voldsomt, hvis ikke du er bekendt 
med at programmere, men sådan er programmet altså opbygget. 
I CS4 er der mulighed for både at vælge Action-Script 2.0 og 3.0 - 
jeg har valgt 3.0 til kurset.
I eksemplerne herunder har jeg forsøgt at ”oversætte” de 2 scripts 
du skal bruge på kurset, til lidt mere forståeligt dansk. Jeg har 
givet farver til de dele af teksten, der bliver farvet i script vinduet.
Der findes heldigvis mange bøger om ActionScript, og hvis du vil 
arbejde seriøst med Flash, er dette et område du studere dybere. 

Du opretter ét lag til 
ActionScriptet.
Al programmerigen 
skrives i det samme 
script. Her er den 
nederste del gjort 
grå, forklaringen til 
denne del af scrip-
tet, står på næste 
side.
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ActionScript
URL request
 - ved klik på knappen, åbnes en side fra Internettet

Forklaring
var request:URLRequest >  anmodning om at gå til en www adresse. 
»http://www.dmi.dk« >  www adressen
www_btn >  Knappen du har navngivet.
addEventListener(MouseEvent.CLICK: >  ”Lytter på”, registrerer at der klik-
kes på knappen.
www >  Et tilfældigt navn, som du synes er logisk. 
navigateToURL>  Når knappen »hører« navnet www, så udfører den en 
funktion. I dette tilfælde at gå til den ovennævnte URL. (vist med grønt)
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Opgavebeskrivelse 
For at knappen kan bruges til noget, skal den tildeles en action som 
fortæller Flash, hvad der skal ske, når knappen aktiveres af bruge-
ren. 

•	 Åbn filmen sommerfugl.fla
•	 Markér button spil på Stage og navngiv den spil_btn i feltet som 

viser <Instance Name> i Properties
•	 Opret et nyt lag, kald det actions. Lås det.
•	 Markér første frame i det nye lag og åbn scriptvinduet (F9).

•	 Skriv nedenstående script. Det er vigtigt at du skriver det     
nøjagtigt som vist, ellers vil du ikke få det til at virke.

•	 Arkivér filmen og vælg Ctrl+enter for at se om knappen virker.
•	 Åbn scriptvinduet igen, og tilføj nedenstående script fra linie 8. 

ActionScript

I ”Læs mere om.. 
ActionScript” har jeg 
forsøgt at oversætte 
scriptet til mere 
forståeligt dansk.

Dette script bevirker, 
at filmen spilles igen, 
når knappen spil 
bliver aktiveret.

Dette script bevirker, 
at brugeren bliver 
ledt hen til en ny URL 
når knappen www 
bliver aktiveret
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ActionScript

Timeline med alle lag til filmen.
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Opgavebeskrivelse 
Du skal afslutte kurset med at fremstille en film, hvor du anven-
der de lærte teknikker og funktioner. Filmen skal vise et akvarie/et 
havmiljø, dog skal du ikke lade dig begrænse af virkeligheden, brug 
fantasien! På kursets hjemmeside, kan du se et par eksempler til 
inspiration.

Forslag: Tegn nogle sten og en sandbund, bobler og en fiskekrog. 
Eller hvad med en gammel støvle eller en indkøbsvogn, eller en 
mobiltelefon eller en skattekiste eller… ?

Filmen skal indeholde
Movie Clips
Tangplanter, der placeres på hvert sit lag, således at fiskene kan 
svømme ind i mellem dem. Brug funktionen Reverse Frames såle-
des at tangplanterne svajer i vandet og ikke hakker.

Motion Tween med Guide eller Classic Tween
Fisk og andre havvæsener, der svømmer. 

Baggrund
Kan være tegnet eller det kan være et foto. Det er tilladt at tegne 
udenfor Stage.

Actionscript
Der indsættes en stopaction.

Knapper
2 knapper; Én spiller filmen igen, den anden linker til Danmarks 
Akvarium.

Planlægning, tips og tricks 
•	 Tegn filmen på et stykke papir inden du starter
•	 Start med at sætte størrelsen på Stage
•	 Brug mange lag, hvert element - sit lag
•	 Brug Movie Clip, både for overskuelighedesns skyld, men også 

for dynamikken
•	 Overvej hvad der skal være Movie Clip og hvad skal være 

Tweens.
•	 Brug gerne både fotos og grafik

Aflevér opgaven som aftalt med din underviser.

Rigtig god fornøjelse

Akvariet
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